INDUSTRIAL SHIELDS

PLC ARDUINO ARDBOX 20 I/Os ANALOG HF PLUS

MODBUS

PLC ARDUINO
ARDBOX 20 I/0s
ANALOG HF

PLUS




Ref.IS.AB20AN.HF+ Rev.0: 30-08-19



PLC Arduino ARDBOX 20 1/0s
Analog HF PLUS User Guide

Revised August 2019

This user guide is for version PLC Arduino ARDBOX 20 [/Os Analog HF
PLUS, ABOX-103-001-8 with Reference name Ref.IS.AB20AN-HF-PLUS
For older versions refer to user guide with Cat. No. ABOX-103-001-72



Preface

This User Guide is been implemented by Boot & Work, S.L. working
under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience
This User Guide is intended for the following audience:

e Persons in charge of introducing automation devices.
e Persons who design automation systems.

e Persons who install or connect automation devices.

e Persons who manage working automation installation.

& Warnings:

e Unused pins should not be connected. Ignoring the directive may damage the
controller.

e Improper use of this product may severely damage the controller.

e Referto the controller’s User Guide regarding wiring considerations.

e Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

e Maintenance must be performed by qualified personnel familiarized with the
construction, operation, and hazards involved with the control.

e Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

e Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

e The Ardbox Family PLCs are Open Type Controllers. It is required that you install the
Ardbox PLC in a housing, cabinet, or electric control room. Entry to the housing,



cabinet, or electric control room should be limited to authorized personnel. Failure to
follow these installation requirements could result in severe personal injury and/or
property damage. Always follow these requirements when Ardbox family PLCs.

In case of installation or maintenance of the Ardbox please follow the instructions
marked in the Installation and Maintenance section.

Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

Avertissements:

Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le controleur.

Une utilisation incorrecte de ce produit peut endommager gravement le contréleur.
Reportez-vous au Guide de I'utilisateur du contréleur pour les considérations de
cablage.

Avant d’utiliser ce produit, il incombe a I'utilisateur de lire le Guide de I'utilisateur du
produit et la documentation qui 'accompagne.

La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au contréleur.

La maintenance doit étre effectuée avec I'équipement hors service et déconnectée de
toutes les sources d'alimentation.

Faites attention lors de I'entretien des composants sensibles a I'électricité statique.
Les recommandations du fabricant pour ces composants doivent étre suivies.

Les automates de la famille Ardbox sont des controleurs de type ouvert. Il est
nécessaire d'installer I'automate Ardbox dans un boitier, une armoire ou une salle de
contrdle électrique. L'accés au boitier, a I'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de l'installation des automates de la
famille Ardbox.

En cas d'installation ou de maintenance du Ardbox, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

Ne débranchez pas I'équipement en présence d'une atmosphére inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmosphére
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.



Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESSIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

¢ Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machines, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

e Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.



Intended use or of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in
the catalogue and the associated technical documentation. If third-party products and
components are used, they must have been recommended or approved by Industrial
Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct It
must respect the permissible ambient conditions. You should also follow the indications
and warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or
manipulated by qualified personnel for the task entrusted and observing what is
indicated in the documentation corresponding to it, particularly the safety instructions
and warnings included in it. Due to their training and experience, qualified personnel
are in a position to recognize risks resulting from the handling or manipulation of such
products / systems and to avoid possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result of
INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.

Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons.

It is our practice to change model numbers when features are changed, or published
ratings or when significant construction changes are made. However, some
specifications of the products may be changed without any notice. When in doubt,
special numbers may be assigned to fix or stablish key specifications for your
application on your request. Please consult with your INDUSTRIAL SHIELDS
representative at any time to confirm actual specifications of purchased products.



Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.

The control and drive components of an Industrial Shields PLC are approved for
industrial and commercial use in industrial line supplies. Their use in public line
supplies requires a different configuration and/or additional measures. These
components may only be operated in closed housings or in higher-level control
cabinets with protective covers that are closed, and when all of the protective devices
are used. These components may only be handled by qualified and trained technical
personnel who are knowledgeable and observe all of the safety information and
instructions on the components and in the associated technical user documentation.
When carrying out a risk assessment of a machine in accordance with the EU
Machinery Directive, the machine manufacturer must consider the following residual
risks associated with the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning,
operation, maintenance, and repairs caused by, for example: — Hardware defects
and/or software errors in the sensors, controllers, actuators, and connection technology
- Response times of the controller and drive — Operating and/or ambient conditions not
within the scope of the specification — Condensation / conductive contamination -
Parameterization, programming, cabling, and installation errors — Use of radio devices /
cellular phones in the immediate vicinity of the controller — External influences /
damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by,
for example: - Component malfunctions — Software errors — Operating and/or
ambient conditions not within the scope of the specification — External
influences / damage.

3. Hazardous shock voltages caused by, for example: — Component malfunctions -
Influence of electrostatic charging — Induction of voltages in moving motors — Operating
and/or ambient conditions not within the scope of the specification - Condensation /
conductive contamination — External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose
a risk to people with a pacemaker, implants or metal replacement joints, etc. if they are
too close.

5. Release of environmental pollutants or emissions as a result of improper operation
of the system and/or failure to dispose of components safely and correctly.



Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-
INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS.
ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE
REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY,
REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL
SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR
REPAIR.



10.1
10.2

11.
111

111

12.
13.
14.
15.
16.
17.

Table of Contents

Ardbox Analog HF: General FEAtUIes.........cocciiiiieciiie ettt et 11
Technical SPeCIfiCatioNs ......ciivciiie i e e 12
General SPECIfiCatioNS: ... ..ciiicciiiee e e 12
Performance SPecifiCation: ........ccceeeiciiiieeiiee e 12
3V 2] oTe] [T =4V PSPPI 13
o =Tor- 10 o] o [T 14
F AN o [V 1o X =T - [ o IR UUUUR 14
Tal =Y Ve [=To I XU e [T=T ool R 14
CTT oY= |l 2 = ToF: [V 1 Lo PSPPSR 14
Yo ] i a N L=l o] =Y = ol TS 14
How to connect PLC Arduino 0 PC.....ccocuiiiiiiiiie ettt e e e e 17
How to connect PLC 10 POWET SUPPIY coeeeiiieeciiie ettt ettt e 18
Ardbox ANAlOZ 1/0 PINOUL: ..ecceveiceeccee ettt ettt et e 20
Z0NE CONNECLIONS .cieiiiiiieee ettt e ettt e e e e s s et e e e e s e s ssbbreeeeeessesassaneeeas 20
SWitCh cONFIGUIAtION ..evveiiieeee e 22
General Switches Configuration..........ccccueeeieciiii e 22
RS- 485 Switch configuration .........cooeciieiiiiiiie e 24
RS-232 Switch configuration .......c..eeeeciiiiiiciee e 25
12C Switch configuration ........cooviiii i 25
JUMPEr CoNfiGUIAtION.......eiiie et e e et e e e e aaaeeaeas 26
Hardware Serial RS-232 & RS-485 Configuration........cccccccueeeecciieeeeciiiee e, 27
Hardware Serial RS-485......couiiiiiiiiiieieeeite ettt ettt e e s 27
Hardware Serial RS-232.....ccoiiiiiiiiieeiieceite ettt et 28
Ardbox - Arduino 1/OS 5V PiNS....c.ueeecueieciieetieecteeeecteeeeteeeteeeeteeeeeveeeeteeeeveeeteeeeareean 28
[2C PINS = SDA/SCL wreuteeieectiecte ettt te et e st e s te e e te e te e s taesaaesaaesnbeebeesaenraas 29
AT A =T T ST 29
[/0 t@CHNICAl AETAIIS c.uviieieeeiieieeteee ettt ettt e s eab e e e s s aae e e ssbbeeesssaeeesas 30
B Y/ o1 [or=] I @] oY Y=Yt o] o U 33
(0] o] T=Tor o] e 11 = Y| K3 37
ARDBOX Family DiMENSIONS . .ueiiiiciiieeiiiiieeeciteeeeeitieeeeeiteeeessveeeeesbeeeeesseeeessssaeessnnns 38
Installation and MaiNTENANCE ......ueeiiii i 39



Ref.IS.AB20AN.HF+

Rev.0: 30-08-19

10



1. Ardbox Analog HF: General Features

Supply Yaltage

24 \cce

I/Os

Digital
Analog

COMPACT PLC ARDUINO ARDBOX 201/0s
ANALOG HF PLUS

Fuse protection (2.5A)

Analog Output 8bit
(0-10Vcce)

Input Voltage 12 to 24vdc Polarity protection
Input rated voltage 24 Vde
Rated Power 30w
| Max. 1,5A
Size 100x45x115
Clock Speed 16MHz
32KB of which 4KB are used by
Flash Memory bootloader
SRAM 2.5KB
EEPROM 1KB
. . 12C -- USB -- RS232 -- RS485 --
Communications SPI - TTL RS485
TOTAL Input points 10
TOTAL Output points 10
0 to 10Vac
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vac
An/Dig Input 10bit
(0-10Vcce) 7 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24 Vdc
* Interrupt isolated Input iy 28 7 to 24vdc
I min: 2to 12 mA I min: 3/6 mA
HS Galvanic Isolation Se arated PCB around
(24Vce) Rated Voltage: 24Vdc p 9
0 to 10Vac
I max: 20 mA

Separated PCB ground
Rated Voltage: 10Vac

Digital Isolated Output
(24Vce)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Imax 24Vdc: 410 mA

PWM Isolated Output
8bit (24Vcc)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

PWM Isolated
Output 8bit (24vcce)

Expandability

12C — RS232 — RS485 — SPI - TTL

Reference

IS.AB20AN.HF+
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2. Technical Specifications

2.1  General Specifications:

Power supply

voltage DC power supply 12t024vdc ===
Operating
voltage range DC power supply 11.4t025.4Vdc ===
o DC power supply 30VAC max.

consumption

External

Power supply voltage 24vdc ===

power supply

Power supply output
capacity

700 mA

Insulation resistance

terminal.

20MQ min. at 500Vdc between the AC terminals and the protective ground

Dielectric strength

2.300 VAC at 50/ 60 Hz for one minute with a leakage current of 10mA
max. Between all the external AC terminals and the protective earth
terminal.

Shock resistance

80m/s? in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

0° to 60°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage) -20° to 60°C
Power supply holding time 2ms min.
350g max.

Weight

2.2 Performance Specification:

Arduino Board

ARDUINO LEONARDO

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform
composed of a programming language. “similar to the C”.
http://arduino.cc/en/Tutoria/HomePage

Microcontroller

ATmega32u4

Flash Memory

32KB of which 4KB are used by bootloader

Program capacity (SRAM)

2.5KB

EEPROM

1KB

12



http://arduino.cc/en/Tutorial/HomePage

Clock Speed

16MHz

2.3  Symbology

Table that includes all the symbology that is used in the serigraph of the Ardbox Analog HF+:

Symbol Standard No./ Standard
Standard Title Reference No. / Symbol Meaning
Symbol Title
IEC 60417 / : : .
—— Graphical symbols 5031 / Direct Indicates that the equipment IS
E B . suitable for direct current only;
for use on Current . ; .
. to identify relevant terminals
equipment
IEC 60417/ Indicates that the equipment is
Graphical symbols 5032 / Alternatin suitable for alternating current
N for use on 9 only; to identify relevant
: Current .
equipment terminals
IEC 60417 /
Graphical symbols 5130 / Pulse To _|dent|fy the_control by
for use on which a pulse is started.
; General
equipment
IEC 60417/ To identify an earth (ground)
Graphical symbols terminal in cases where
for use on 5017/ Earth, neither the symbol 5018 nor
‘ . Ground . . :
equipment 5019 is explicily required.
IEC 60417 / . . .
Graphical symbols To identify the swﬁch by
means of which the signal
for use on 5115/ Slgnal lamp ) )
) lamp(s) is (are) switched on or
equipment

off.

q

Medical Devices

CE marking indicates that a
product complies with

Directive CE Marking applicable European Union
93/42/EEC regulations
ISO 7000/ . .
Graphical svmbols Indicates a potentially
o o 0434B / hazardous situation which, if
equioment Warning symbol not avoided, could result in
quip death or serious injury
ISO 7000/
Grap;(r)\:clisygnbols 5036 / Dangerous To indicate hazards arising
equipment Voltage from dangerous voltages

13




3. Precautions

Read this manual before attempting to use the ARDBOX 20 I/Os Analog HF PLUS and follow its
descriptions for reference during operation.

3.1 Arduino Board

The ARDBOX 20 I/Os Analog HF PLUS PLCs include Arduino Leonardo Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate Ardbox according to the performance specifications described in this
manual.

Before using ARDBOX 20 1/Os Analog HF PLUS under different conditions from what has been
specified in this manual or integrating ARDBOX 20 I/Os Analog HF PLUS to nuclear control
systems, railroad systems, aviation systems, vehicles, combustion systems, medical
equipment, amusement machines, safety equipment and other systems, machines, and
equipment that may have a serious influence on lives and property if used improperly, consult
your INDUSTRIAL SHIELDS representative. Ensure that the rating and performance
characteristics of Ardbox are sufficient for the systems, machines, and equipment, and be sure
to provide the systems, machines, and equipment double safety mechanisms. This manual
provides information for programming and operating the Ardbox.

4. Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed using directly C but it is much easier working with
Arduino IDE as it provides lots of libraries that helps in the programming.

Furthermore Industrial Shields provides boards for programming the PLCs much easier.
Basically it is no needed to define the pins and if that pins are inputs or outputs. Everything is
set up automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.
Requirements:

Arduino IDE 1.8.0 or above (better to have always the latest version).

14



Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences

Settings Networl:

Sletchbool: location:

Cr\Users\Albert\Documents\Arduino
Editor language: English (English)
Editor font size; 15

Interface scale:

Compiler warnings: Nome

[(pisplay line rumbers
[CJEnable Code Folding

[] verify code after upload
[Juse external editor

Check for updates on startup

Save when verifying or uploading

[] Automatic | 100 3 %
Show verbose output during compilation upload

Update sketch files to new extension on save (pde -> .ino)

Browse

| (requires restart of Arduino)

(requires restart of Arduing)

Additional Boards Manager URLs: )'mp://apps‘\ndusrrla\sh\elds.com/ma\n/ardu\nn/hnards/pac%aqe_mdusmaIsh\e\ds_mde' ﬁ

7 in the file

Ci\Users\Albert\AppDatall ocal\Arduino15\preferences. it

(editonly when not running)

Ok Cancel

2. In Additional Boards URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields

index.json

3. Press OK to save the changes.

4. Goto: Tools -> Board: ... -> Boards Manager

@ sketch mar16a | Arduino 180

File Edit Skewh Tools Help

Auto Format

Archive Sketch

Fix Encoding & Reload
Serial Monitor

Serial Plotter

WAFi101 Firmware Updater
Board: "M-Duino family”
Inchustrial Shaelds. “M-Duing 58+
Port

Get Board Info

) Programmer. “Archino as ISP
Burn Bootloader

- _
]

Boards Manager...
Ardy R Boarc

Archuino Yiin

Arduino/Genuino Uno

Arduino Duemilanove or Diecimila
Arduino Hano

Arduino/Genuino Mega of Mega 2560
Ascluin Mega ADK

Arduino Leonardo

Arduino Leonardo ETH
Arduino/Genwino Micro

Ascluino Esplora

Arduino Wini

Arduino Ethernet

Ardhino Fio

Arching BT

LilyPad Ardino USE

LilyPad Arching

Arduine Pro o1 Pro Mini

Archuin NG or older

Asduin Robot Control

Arduine Robat Motor

Ardino Gemma

Adalruit Cireuit Playground
Ascluine Yuin Mini
Arduino Industrial 101
Linino One
Archuin Uno WiFi

15


http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json

5. Search for industrialshields.

& Boards Manager %
Type All ~ | lindustrialshields
industrialshields ~

Boards included in this package:
ARDBOX family, M-Duino family.
Online help

More info

Install

Close
6. Click install (selecting the latest version).
Following this steps you will be able to use now the Industrial Shields Boards:

File Edit Sketch Tools Help

Auto Format CuteT
Aschive Sketch
ketch_aug2s|  Fix Encoding & Reload

(| Manage Libraries Cri+Shiftel ~
Serial Monitor Curt+ShiftsM
Serial Plotter Cri+Shift+L

WIFI101 / WIFININA Firmware Updater

Board; “Ardbox WIFI/BT family" 3 Boards Manager
Model: "Ardbox Analog HF + w/ HW RS-232 WiFi/BT* &
1 M5Stack-FIRE

Get Board Info M5Stick-C

ODROID £5P22

Heltec Wifi Kit 32

Heitec Wifi LoRa 32

Hettec WiFi LoRa 32(v2)

Heltec Wireless Stick

ESPectro3?
Microduino-CoreESP32

ALKS ESP32

Wity 30

BPI-BIT

Silicognition WESPI2

T-Beam

D-duino-32

LoPy

LoPyd

OROCA EduBot

£5932 FM DevKit

Frog Board ESP32

Al Thinker ESP32-CAM

SparkFun LoRa Gateway 1-Channel

Programmer: “Arduino Gemma™
Burn Bootioader

WiFi module

Boox family
Ardbox GRS family
Ardbox WIFI/BT family
M-Duino family

Once the Ardbox Family is selected, an extra option will appear on Tools:

16



- Select the correct Ardbox Analog HF PLUS Board (Ardbox Analog HF+ w/HW RS-232 or
Ardbox Analog HF+ w/HW RS-485) depending on your jumpers & switch configuration.

© sketch_aug26a | Arduin 189
File Edit Sketch Toals Help

Auto Format Cul+T
Archive Sketch
sketch_aug26| Fix Encoding & Reload

(  Manage Libraries.. Ctrloshiftal
Serial Monitor Cut+Shiftsh4
Serial Plotter Ctrl+Shift+L

WIFi101 / WiFININA Firmware Updater

Board: “Ardbox WIFI/BT family” >

Maodel. “Ardbox Analog HF + w/ HW RS-232 WiFI/BT" 3@ Ardbox Analog HF+ w/ HW RS-232 WiFi/BT
t Ardbox Analog HF + w/ HW RS-485 WiFi/8T

Get Board Info Ardbox Relay HF + w/ HW RS-232 WiFi/8T

T - Ardbox Relay HF+ w/ HW RS-485 WiF /8T
Pragrammer: “Arduina Gemma

Bum Boatioader

Also there are some examples of programming in File -> Examples -> Ardbox Family.

Furthermore there are some extra libraries that can be found in Industrial Shields github.

https://github.com/IndustrialShields/

5. How to connect PLC Arduino to PC

- Connect USB port from PLC to PC.

NOTE:
Ardbox Family uses micro USB cable.

- Open Arduino IDE interface:
- Select Industrial Shields boards -> Ardbox Family

17


https://github.com/IndustrialShields/

- Select correct port.

@ sketch_mar16a | Arduino 180
File Edit Sketch Tools Help

Auto Format colsT
Archive Sketch
£ FixEncoding & Reload

| Senl Monitor o eShittob
Serial Poiter Colshittel

WIF101 Firmware Updater
Boardt “Ardbas family”

Inchustrial Shields: “Ardbox Analag”

¥ GetBoard Info

Programmer:“Arduina as 159"
Bum Baotioader

Senal ports
COM13 {Arching Leonardo)

6. How to connect PLC to power supply

- Ardbox Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT

REVERSAL!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

|::"."1.' ER SUP PLTl

GND 4
24Vdc

GND I

|—f 24Vos |

A ——

18



- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm

DIN Rail: g
-12Vdc / 24Vdc o
-2.5A

30W

Industrial Shields power supplies provide parallel
operation, overvoltage protection, and overcurrent
protection. There is a LED inductor for power status,

TRy

the power supply is certified according to UL.

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-
1.

WARINING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of
the equipment must be separated from the dangerous voltage cables.
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7. Ardbox Analog I/0 pinout

7.1 Zone Connections

LEFT ZONE
5 £

<5 |5 5

AR c 2

o < = 3]

) = 5

<O < (I}
A0.6 3 Analog Out
A0.5" 5 Analog Out
A0.4* 6 Analog Out
A0.3" 9 Analog Out
A0.2 10 Analog Out
A0.1* 11 Analog Out
A0.0* 13 Analog Out
Q0.9 1 Digital Output
Q0.8? 0 Digital Output
Q0.7 7 Digital Output
Q0.6" 3 | PwWMdigital Output
Q0.5 5 PWM/digital Output
Q0.4 6 PWM/digital Output
Q0.3 9 PWM/digital Output
Q0.2 10 PWM/digital Output
Q0.1 11 PWM/digital Output
Q0.0 13 PWM/digital Output

GNDCOM - GND
24VCOM - Power Supply

GNDCom
24VCom

GND

24V

WAPZ=ZL

" 413444443044 ¢

! See section 8 to enable these connections

% See section 9 to enable these connections

LEFT ZONE

Switch config*

(see section 8 for Communications
configuration. Enabling Communications
disables some 1/0s)

Analog Outputs pins

Digital Outputs pins

Power supply connectors
(24vdc - GND)
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RIGHT ZONE

RIGHT ZONE

s | £b &0

< ° ° I o I c

o2 c N c 2

S E 38 | 2% g

Ts Sy | S 5

<O <X <X [

A+? - - RS485(A)

B-'? - RS485(B)

Y+11'22 - - RS485§Y;

z-" - - RS485(Z
SCL-PIN3! 3 3 SCL(12C)
SDA-PIN2! 2 2 SDA(I2C)
TX-RS232"2 1 4 -
RX-RS232" 0 8 -

5V - - 5Vout DC

RESET - - RESET

SCK - - SPI

MOSI - - SPI

MISO - - SPI

10.9 18 18 Analog/Digital Input

10.8 19 19 Analog/Digital Input

10.7 20 20 Analog/Digital Input

10.6 21 21 Analog/Digital Input

10.5 22 22 Analog/Digital Input

10.4 23 23 Analog/Digital Input

10.3 8 8 Digital Input

10.2" 4 4 Digital Input

10.1 12 12 Digital Input

10.0 2 2 Digital interrupt

HS*: Hardware Serial
SS*: Software Serial

COMUNICATION SWTCH

#See Ouput Switch
126105

ON

DE-RS485
AD2-Q02*
RX-RS485
AD.1-Q0.1*
SCL-D2/10.0

RS485
103
| — |

Switch config*

(see section 8 for Communications
configuration. Enabling Communications
disables some 1/0s)

SDA-D3/ Q06
OFF N

A+
B-
Y+
Z-

RS485
Half /Ful

SCL-PIN3
SDA-PIN2

12¢-ss

NC
NC

GND
5V
5 RESET

Communications pins

SCK
MOSI
MISO

1 See section 8 to enable these connections

2 See section 9 to enable these connections

Digital/Analog Inputs

NOTE: Although in the serigraphy it is not shown the RS232 communication pins, in the reality
it exists. The change that has to be done is the following:

configuration)

0 (SO DEFAULT SERIGRAPHY CORRECT SERIGRAPHY
g | sDAPN2 SDA-PIN2 SDA-PIN2
NG NC TX-RS232
ono NC RX-RS232
| oreer GND GND
[ F
3833338332 4ght
O O ol © 0,0 O gz i
S =
O 0 O Qo /o 00 o | W
o= = = o T —— W RERET
/ S o S 5 als 8 8 5
Config switch *
(see section 8 for communications Input / Output Power LED Arduino Reset

button
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NOTE: Although in the TOP ZONE serigraphy it is shown Q0.9 & Q0.8 pins, in the reality they
are 10.310.2 pins respectively. Additionally although the serigraphy only is expressed for the
RS485 it is also the same for the RS232. So if it is desired to enable any of the Hardware Serial
connection this is the function of these switches. See chapter 8 for more information

A

| RS485/R$232 HS | 10.2 | RS485/RS232 HS

8. Switch configuration

8.1

LEFT ZONE.

General Switches Configuration

Communications and inputs/outputs can not work simultaneously.

LEFT ZONE

SWITCH

OFF

ON

DE-RS485

A0.2-Q0.2*

DE-RS485

D10/A0.2-Q0.2

DE-RS485

A0.2-Q0.2

RE-RS485*

A0.1-Q0.1*

RE-RS485

D11/A0.1-Q0.1

RE-RS485

A0.1-Q0.1*

SDA-D2/10.0*

SDA-D2

10.0

SCL-D3/Q0.6*

SCL-D3

Q0.6

SWITCH

*See Output Swhch

*|2C switch serigraphy is turned around. It should be: (SDA-D2 , SCL-D3). RX-RS485 should be RE-RS485

6. DE-RS485 — If this switch is ON, the A0.2-Q0.2 switch must be set to OFF. Being in ON mode
it enables DE for the RS-485.

5. A0.2-Q0.2 — If this switch is ON, the DE-RS485 switch must be set to OFF. Being in ON mode

it enables the outputs A0.2-Q0.2.

4. RE-RS485 — If this switch is ON, the A0.1-Q0.1 switch must be set to OFF. Being in ON mode
it enables EE for the RS-485.

3. A0.1-Q0.1 - If this switch is ON, the RE-RS485 switch must be set to OFF. Being in ON mode

it enables the outputs A0.1-Q0.1.

2. SDA-D2/10.0 — Choosing between SDA (12C) / Pin2 and 10.0. If this switch is ON, the 10.0 input
will be enabled and the SDA / Pin3 will be disabled. If this switch is OFF, the SDA / Pin2 will be

now available and 10.0 disabled.
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1. SCL-D3/Q0.6 — Choosing between SCL (12C) / Pin3 and QQ.6. If this switch is ON, the Q0.6

input will be enabled and the SCL / Pin3 will be disabled. If this switch is OFF, the SCL / Pin3 will
be now available and Q0.6 disabled.

TOP ZONE

TOP ZONE
SWITCH OFF ON
10.3 RS485/RS232 HS 10.3

RS485/RS232 HS

10.3

RS485/RS232 HS

10.2

RS485/RS232 HS

10.2

RS485/RS232 HS

10.2

RS485/RS232 HS

i

NOTE: Although in the TOP ZONE serigraphy it is shown Q0.9 & Q0.8 pins, in the reality they
are 10.3 10.2 pins respectively. Additionally although the serigraphy only is expressed for the

RS485 it is also the same for the RS232. So if it is desired to enable any of the Hardware Serial

connection this is the function of these switches. See chapter 8 for more information

«—»|103

| RS485/RS232 HS | 10.2 | RS485/RS232 HS

1. 10.3: If this switch is ON, the RS485/RS232 HS switch must be set to OFF. Being in ON
mode it enables 10.3.

2. RS485/RS232 HS: If this switch is ON, the 10.3 switch must be set to OFF. Being in ON
mode it enables the DO for the RS-485 or RS-232 Hardware Serial (see section 9 for
jumper configuration)

3. 10.2: If this switch is ON, the RS485 switch must be set to OFF. Being in ON mode it

enables 10.2.

4. RS485/RS232 HS: If this switch is ON, the 10.2 switch must be set to OFF. Being in ON
mode it enables the D1 for the RS485 or RS-232 Hardware Serial (see section 9 for
jumper configuration
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RIGHT ZONE SWITCH

RIGHT ZONE
SWITCH OFF ON

H/F Full Duplex Half Duplex

Q0.6 ANALOG (AO0.6) DIGITAL (Q0.6)
Q0.5 ANALOG (A0.5) DIGITAL (Q0.5)
Q0.4 ANALOG (A0.4) DIGITAL (Q0.4)
Q0.3 ANALOG (A0.3) DIGITAL (Q0.3)
Q0.2 ANALOG (A0.2) DIGITAL (Q0.2)
Q0.1 ANALOG (A0.1) DIGITAL (Q0.1)
Q0.0 ANALOG (A0.0) DIGITAL (Q0.0)

RIGHT ZONE. The right zone configures the outputs. If the switch is set to “ON” the Q0.X will
have the behaviour of a digital output. If it is set to “OFF” it will be analog. There is also a
switch for switching between Half and Full Duplex. It is “ON” for Half Duplex and “OFF” for Full

Duplex.

8.2 RS- 485 Switch configuration

Having this setup, the 10.3 & 10.2 are disabled

TOP ZONE

SWITCH | MODE

10.3 OFF

for the RS-232.

RS485 HS ON

0.2 OFF

RS485 HS ON
LEFT ZONE

SWITCH CONFIGURATION

SWITCH MODE
DE-RS485 ON
D10/A0.2-Q0.2 OFF
RE-RS485 ON
D11/A0.1-Q0.1 OFF
SDA-D2/10.0
SCL-D3/Q0.6

RS-485 LEFT ZONE: In order to enable the RS-485 communication
protocol it is necessary that the switches of the left zone are
configured as it is showed in the table.

The ones marked with “-“ mean that they don’t affect the RS-485
communication protocol

RS-485 TOP ZONE: In order to enable the RS-485 protocol the TOP ZONE
must be configured as it is shown in the table.
Although the switch serigraphy is only referenced to RS-485 it is also the
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8.3  RS-232 Switch configuration

TOP ZONE

SWITCH | MODE

10.3 OFF

RS232 HS ON

10.2 OFF

RS232 HS ON

RS-232 TOP ZONE: In order to enable the RS-232 communication protocol it is
necessary that the switches of the top zone are configured as it is shown in
the table.

Although the nomenclature is not referenced to the RS-232, this switches
relates the hardware serial of the Arduino board.

LEFT ZONE

RS-232 LEFT ZONE: In order to enable the RS-232 communication protocol

swiTcH | mope| it is necessary that the switches of the left zone is configured as it is

DE-RS485 OFF

showed in the table.

D10/A0.2-Q0.2 ON

RE-RS485 OFF

The ones marked with “-“ mean that it does not affect the RS-232

D11/A0.1-Q0.1 ON

communication protocol

SDA-D2/10.0

SCL-D3/Q0.6

8.4  12C Switch configuration

TOP ZONE LEFT ZONE
SWITCH MODE SWITCH MODE
10.3 DE-RS485

RS485/RS232 HS

D10/A0.2-Q0.2

10.2

RE-RS485

RS485/RS232 HS

D11/A0.1-Q0.1

SDA-D2/10.0 OFF

SCL-D3/Q0.6 OFF

12C: Enable SCL and SDA connections (direct Arduino pins) with configuration switches. 10.0

and Q0.6 will not be available. In order to implement this communication a 4.7kQ pull-up
resistor (IS.ACI2C-4.7K) is required.
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9. Jumper Configuration

General Jumper Configuration

JUMPER ZONE 1

LEFT RIGHT
RS-485 RS-485
DO D1
RS-232 RS-232

JUMPER ZONE 2

LEFT RIGHT
10.2 10.3
D4 D8
RS-232 SS RS-232 SS

This jumper makes the choosing between connecting MAX232 to pins
0,1 of the Arduino Leonardo or with the MAX485. In order to use the
RS-232 Hardware Serial protocol both RS-232 must be connected to
the D1/DO. In order to use the RS-485 Hardware Serial protocol both
RS-485 must be connected to the D1/DO.

This jumper zone makes the choosing between connecting the inputs
10.2, 10.3 to pins 4 and 8 of the Arduino Leonardo respectively, or
connect the RS-232 ports to activate the Software Serial RS-232. In
order to use the inputs 10.2,10.3 the jumper must be connected to the
pins 4 and 8. So 10.2 must be connected with D4 and 10.3 must be
connected to D8.

*The jumpers that are not connected to the middle jumpers MUST NOT be Connected anywhere.

| X t o0
oo 11 oo 11
RS-485 R5-232 Digital RS-232

HARDWARE ~ HARDWARE
SERIAL SERTAL i SERTAL

SOFTWARE
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10. Hardware Serial RS-232 & RS-485 Configuration

10.1 Hardware Serial RS-485

In order to enable the Hardware Serial RS-485 the total configuration of the Ardbox Analog HF
will be:

Switch configuration:

LEFT ZONE
TOP ZONE SWITCH | MODE
SWITCH MODE DE-RS485 ON
10.3 OFF D10/A0.2-Q0.2 | OFF
RS485 HS ON RE-RS485 ON
10.2 OFF D11/A0.1-Q0.1 | OFF
RS485 HS ON SDA-D2/10.0
SCL-D3/Q0.6
Jumper configuration:
JUMPER ZONE 1 JUMPER ZONE 2
LEFT RIGHT
LEFT RIGHT 10.2 10.3
D8

RS-485 RS-485
D4
DO D1

Having configured Ardbox Analog HF PLUS as it is shown above, these are the features that are

available:

o Available communication protocols:
e Hardware Serial RS-485.
e |2C *If 12C is active 10.0 & Q0.6 are disabled

o SPI|
e TTL (SoftwareSerial)
e USB

o Inputs: 8 out of 10 inputs, 10.0, 10.1 and 10.4 to 10.9. If using 12C 10.0 is also disabled
o Digital Outputs: All 10 outputs. If using 12C Q0.6 is disabled.
o Analog Outputs: From A0.0 to A0.6. If using 12C A0.6 is disabled
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10.2 Hardware Serial RS-232

In order to enable the Hardware Serial RS-232 the total configuration of the Ardbox Relay HF
will be:

Switch configuration:

LEFT ZONE
SWITCH MODE Note: The switches of the left
TOP ZONE zone of the RS-485 don’t
DE-RS485 OFF ) )
SWITCH MODE interfere in the RS-232 HS, the
10.3 OFF D10/A02-Q02| ON thing is that as pins 0 & 1 are
RE-RS485 OFF _
RS232 HS ON reserved for the RS-232, the
10.2 OFF D11/A0.1-Q0.1 | ON RS-485 is totally disabled. As it
: SDA-D2/10.0 } is disabled, there is no point on
RS232 HS ON L .
SCL-D3/Q0.6 configuring these switches as
RS-485 mode
Jumper configuration:
JUMPER ZONE 1 HALF DUPLEX JUMPER ZONE 2
LEFT RIGHT LEFT RIGHT
10.2 10.3

Do D1 D4 D8
RS-232 RS-232 - -

o Available communication protocols:
e Hardware Serial RS-232.
o |2C *If 12C is active 10.0 & Q0.6 are disabled

e SPI
e TTL
e USB

o Inputs: 8 out of 10 inputs, 10.0, 10.1 and 10.4 to 10.9. If using 12C 10.0 is also disabled
o Digital Outputs: All 10 outputs. If using 12C Q0.6 is disabled.
o Analog Outputs: From A0.0 to A0.6. If using I2C A0.6 is disabled

11. Ardbox - Arduino I/0s 5V pins

The Ardbox has some of the Leonardo board pins available. These pins can be programmed
according to Arduino features such as I/Os operating at 5V or any additional features present
in the pins (for example 12C communication in pins SCL and SDA). As this pins are directly
connected to the Arduino Leonardo board they are not as well protect as the normal inputs.
These pins are mainly meant to be used as prototyping.
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Ardbox terminal Arduino pin
SCL-Pin 3 3
SDA - Pin 2 2
MISO 14
SCK 15
MQOSI 16

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 5V.
These terminals provide direct access to the Leonardo board.

A part from the switch configuration there are some special conditions depending on these 5V.
Now it is going to be shown the considerations to operate with these pins.

11.1 12C pins - SDA/SCL

The 12C protocol is meant to work in a pull-up configuration. The 12C pins in the Arduino
Leonardo are not pull-up, so in order to work with the 12C an external pull-up resistor is
required. If it is meant to work as a GPIO at 5V, the switches must be set as 12C, (section 8).

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.

11.1 Pin2/Pin3

These pins are only referred to the inputs 10.5/10.6. If the switch configuration is in OFF
position the pins Pin 2/Pin 3 will be available.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.
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12. 1/0 technical details

Digital Output Waveform

[N o —1
v

DIGITALOUT

DIGITAL OUT
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PWM Waveform

PWHM OUTPOUT

——

v

ANALDG OUT
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Analog/Digital Input Turn-on
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Ref.IS.AB20AN.HF+

13. Typical Connections

Ferrite KIT,

e,

0

SHIELDED CABLE E%

SHIELDED CABLE

Ssnarav
GND

O-10V

£,

n

Y

c @

SHIELDED CABLE J Douatoad D0 MOUNO LAYOUT: \

errite KITA

.7

Rev.0: 30-08-19
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Ref.IS.AB20AN.HF+

o-10v

s, W

Ferrite KITA
'

<

6}

/4

0.7

POWER

Rev.0: 30-08-19

SHIELDED CABLE ) s e Foreg \

Ferrite KI

),
SHIELDEDCABLE{ e — \

SHIELDED CABLE

sn2av
GND

ALWAYS
CONNECTED
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Ref.IS.AB20AN.HF+ Rev.0: 30-08-19

SHIELDED CABLE o rite KITY

GHND
2124V B—

SHIELDED CABLE

* Seo the switch
configutarion (ON)
e &
ALWAYS
n CONNECTED
Ferrte KITA @
GND -
‘E] I‘ VOUT =0/ Vde
SHIELDED CABL \

SHIELDED CABLE
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Ref.IS.AB20AN.HF+

Ferrite KI°

TA

Rev.0: 30-08-19

* See the switch
configutarion (OFF)

{n) v o-1ov)

\Z
SHIELDED CABLE
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14. Connector details

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 THT — 1963502
from Phoenix contact. MC0,5/10-G-2,5THT

For 1/0 and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact. FK-MC 0,5/10-ST-2,5

Connection details:

Article reference  MC 0,5/10-G-2,5 THT
Height 8,1mm
Pitch 2,5mm
Dimension 22,5mm
Pin dimensions 0,8x0,8mm
Pin spacing 2,50mm
Article reference FK-MC 0,5/10-ST-2,5
Rigid conduit section min. 0,14 mm?
Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?
Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20
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15.

ARDBOX Family Dimensions:

45mm width

&

114

DIN rail mounting:

0.3 max

Profilato o cappello TH 35-7,5
Top hat rail TH 35-7,5

755,
RO8
RO8
3
ISR 1004
Sezione A / Section A

2402

s

Prcfiloto a coppello TH 35-15
Top hat rail TH 35-15

15 5

=

1004
15°

R12

R12

22 min. finoa / To 2,5 max

Sezione A/ Sedtion A

CARATTERISTICHE METODO  UNMA'  BLEND FEATURES TEST UNITS  BLEND
DIMISURA PC/ABS METHOD PUABS

Mecconiche R li KSTMDE3  MP Mechanical fest Resistoice o tensil sess f viek ASTADE38 MRy 6
R iong wtug ISTH D38 MPo Tnslestongth ASTIDE38 MRy L}

Alungameto o ot KSTHD838 % Utimonte elo ASTMD638 % 59

Moduly in fesione KSTHDT0  MPo 2694 Peding modules ASTRDT0 MR il

Provg lz0d con intoglo K018004 XYt rod st otched 150160/14_ Yym' 55

Termiche Temp.di nmmolimento Vit metdo B ST DISS °C 4 Thermal fest Vit sodtering tamperatue metiod B ASTMDIS2S °C 14
Jemperatue Ricty 1 81 MRy KT0648  °C Rehecting temperature 1 81 WPg ASTMDS48 9

Fisiche Peso spadfin KTMOT? gfam3 V] Physical test  Spucic guviy ASTHDTR2 giand 120
Riti nellostompo KSTHDISS % 0408 Mol shink ASTMD9SS % 0406

Mk Flow Index 260°C- 98K ST DIZE g1’ 11 ek Flow bndex 260°C- 98K ASTMDIZS8 gyl 1l
(Comportamento Aukesinguerzs (mm di pesor) o4 V-0(08) Flame fest Saf atinguisher Hideness in rom) uLs4 - V-0({08)
alla fiamma___Fio Incardescen. 37 mm 9521 °C 960 threod 32 mm 169521 °C 960

Inaltronic si iserva il diritto di modificore il moteriole con cui realizzo i propri prodotti

senzo obbligo di preawiiso.

Iraltvonic con operate ony change of the moteriols without being obliged to forewamn.
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16.Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which is apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pair for the I/0 of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particle,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the ARDBOX 20 1/0Os Analog HF PLUS [1/Os PLUS from heat, high voltaje
and eletrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
ARDBOX 20 I/Os Analog HF PLUS. When configuring the layout of the ARDBOX 20 1/Os
Analog HF PLUS inside your panel, consider the heat-generating devices and locate the
electronic-type devices in the cooler areas of your cabinet. Reducing the exposure to a
high-temperature environment will extend the operating life of any electronic device.
Consider also the routing of the wiring for the devices in the electric cabinet. Avoid placing
low-voltage signal wires and communications cables in the same tray with AC power wiring
and highenergy, rapidly-switched DC wiring.
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Provide adequate clearance for cooling and wiring ARDBOX 20 I/Os Analog HF PLUS. Is
designed for natural convection cooling. For proper cooling, you must provide a clearance of at
least 25 cm above and below the devices. Also, allow at least 25 cm of depth between the
front of the modules and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debrisin a
way that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquidfilled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25¢cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by excess of
temperature.
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- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.

- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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Ref.IS.AB20AN.HF+ Rev.0: 30-08-19

17. Revision Table

Revision Number DE(] Changes
0 30/08/2019 It was first implemented
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About Industrial Shields:

Direction: Fabrica del Pont, 1-11

Zip/Postal Code: 08272

City: Sant Fruités de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611
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Mail: industrialshields@industrialshields.com
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